
LaDOTD CAD Standards Help - MicroStation (2013) 

Help Sources 
The “CADconform” menu, which is located on the MicroStation Main menu, contains links to a number 
of help sources, including LaDOTD's Electronic Standards website, LaDOTD CAD Standards Help (this 
file), LaDOTD Plan Delivery_Transition Guide, LaDOTD CADconform Basics, CADconform Help, 
CADconform Reference Guide, Altiva Website and Altiva’s LaDOTD CAD Standards Website.  
LaDOTD provides the following resources: 

 www.dotd.la.gov > Doing Business with DOTD> Electronic Standards for Plans.  This page 
includes a link to Altiva’s LaDOTD CAD Standards web page, ProjectWise downloads, etc. 

 Contact Paul Mandella, at paul.mandella@la.gov for latest LaDOTD CAD standards updates and 
support; and for guidance regarding the ProjectWise plan delivery process. 

 Contact the ProjectWise Manager, David Ringuette at david.ringuette@la.gov for guidance 
regarding general ProjectWise support, security issues, electronic signature support, etc. 

MicroStation Resources Installation 
The DOTD MicroStation Resources download is installed using the Altiva DeployCAD installer.  
DOTD resource files reside in the \LaDOTD_CAD_Standards folder, which is normally installed in 
C:\DOTD\Workspace; or a network folder (e.g., S:\Workspace\projects).  Note: The option to load 
MicroStation Resources in C:\Program Files\ Bentley\Workspace\Projects is no longer available.  For 
additional installation information, read the Installation Notes in the License Agreement. 
The MicroStation Resources download page can be accessed directly at www.altivasoft.com/ladotd/.   

Workspace Projects 
For a list of Workspace Projects, see the “Selecting Workspace Projects” topic below.  Workspace 
Projects are defined in Project configuration files (.pcf), which are located in the 
\DOTD\Workspace\Projects folder.  Project configuration files define folder paths and settings that are 
unique to the associated discipline(s) (e.g., LADOTD_Road-Site).  In ProjectWise, Workspace Project 
configurations are assigned to the ProjectWise Project discipline Plans folder in which they reside (e.g., 
\H.001234\Road-Site\Plans).  When standards are loaded on the C drive or a network drive, the 
Workspace Project must be selected in the MicroStation startup dialog box. 

Selecting Workspace Projects 
Available LaDOTD Workspace Projects and associated functions are as follows: 

LADOTD_Road-Site:  Road, Site, Traffic and Landscape 

LADOTD_Bridge-Facilities:  Bridge, Structural, Mechanical, Electrical, Architectural and Traffic 

LADOTD_Traffic:  Traffic signing, pavement markings and TSI drawings 

LADOTD_Right-of-Way_Map:  Right-of-Way Map drawings 

LADOTD_Survey:  Electronic Survey Graphics 

“No Project”:  Used to conform borders; and to edit dgnlib files (DOTD administrators only).
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Folder Information 

Seed Folder 
Subfolders contain drawing template files that are used to create new files.  Seed folders and files are 
generally named according to the Workspace Project that they serve, such as Road-Site, etc.  Seed file 
folders also include one for Title Sheets. Some important attributes of seed files include border reference 
files, levels, color tables, active settings, and CADconform feature table brands (standards used to 
create/check/certify graphics).  When creating a new file, use the default seed file or select other 
appropriate seed files as needed. 

Border Folder 
Subfolders contain borders that are referenced to seed files and are generally named according to the 
Workspace Project that they serve, such as Road-Site, etc.  Borders are classified as full-size or letter-
size.  Letter-size borders are specified as such (e.g., road-site_seed2d_letter.dgn).  For more information 
about letter-size borders, see LaDOTD Plan Delivery_Transition Guide.doc. 

Border reference files are attached to seed files using the Relative method.  Borders attached using this 
method will display in seed files as long as the Workspace folder hierarchy is maintained.  When new 
drawing files are created in a project design folder, using a copy of a seed file, the border will not 
initially attach and display.  The border file pathname will appear red in the MicroStation References 
dialog box.  The associated border file must be copied into the project drawings folder so that it will 
attach and display when the drawing file is reopened.  The project copy of the border will display in 
drawing files as long as it remains in the project drawings folder, wherever that folder is moved or 
copied.  Exception:  When new drawing files are created or copied into ProjectWise, border reference 
files will not automatically attach and display in this manner.  They must be attached manually.   

Tip:  Use the ProjectWise Scan References utility to resolve reference file attachments for multiple files.  
This utility is particularly helpful when large numbers of project files are imported to the system.  Once 
reference file attachments are resolved, they must be moved to the Reference Drawings folder in order 
to clean up the project master drawings list.  ProjectWise will “remember” the attachments. 

Road Plan-Profile Borders: Specify these border reference attachments in the Inroads Plan and Profile 
Generator as border_road plan-profile_sht4.dgn (border with legend) or border_road plan-
profile_sht5.dgn (following sheets).  Inroads sets the reference scale to 240:1 (urban), and 600:1 rural).  
The global active linestylescale setting is preset in the plan-profile seed files to 20 and 50 respectively.  
This scale is consistent with the Engineering scale of the drawing.  Note: Plan-Profile drawings cover a 
maximum of 300' per sheet at 1”=20'; or 900' per sheet at 1”=50'.  

Road Cross Section Borders: Borders are provided at a scale of 1”=5’ (urban) and 1”=10’ (rural) in the 
border file.  Cross section seed files reference these borders at 1:1 scale.  The global active linestylescale 
setting is preset in the cross-section seed files to 5 and 10 respectively.   

Cell Folder 
Cell files are logically named according to disciplines.  Recommended practice is to place cells using the 
CADconform Draft menu to the greatest extent possible, which will ensure that they are appropriately 
used and scaled.  Some cells are only available in the discipline cell library.   
*User-defined cells (from user cell libraries) may be used in some cases.  Such cells must consist of 
elements that conform to CADconform features.  

Symb Folder 
Symbology resource files contain font and line style definitions that are used when viewing and printing 
drawings.  These files are logically named according to disciplines.
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Dgnlib Folder 

Levels, level filters, text styles and dimension styles are associated with Workspace Project 
configurations.  Examples: 

 Levels and styles for the Bridge-Facilities Project are in bridge-structural.dgnlib. 
 Styles for the Road-Site Project are included in road.dgnlib.   

Applicable “dgnlibs”, which are used to define levels, text styles and dimension styles, are set in the 
Workspace Project configuration file.  When levels and styles are actually used in a drawing file, then 
they are copied into the file.  Level and styles appear in bold type when are being used in a drawing file. 

Exception: “Facilities” levels (for Architectural, Mechanical and Electrical disciplines) are defined in 
seed files rather than dgnlibs, as they were in previous releases.  Levels are generically named (e.g., 
Arch1-Arch20), because required level functions are hard to predict.  User-defined descriptions are 
required to identify levels instead.  See Describing Facilities Levels.   

Macros and UCMs Folders 
These folders contain numerous productivity macros that are used in CADconform Feature Tables, etc. 

Data Folder 
Highlights are as follows: 

 DOTD Color Tables: Contain colors that are used in seed files and borders. 

 Units.def: Defines unit definitions for MicroStation drawing files.  Unit definitions also include 
settings that can be used during file format conversion to fix files that have incomplete unit 
information.  For instance, some DOTD legacy drawings have blank or unrecognized unit labels. 

Docs Folder 
This folder contains menu help files for the DOTD menu and the BridgeFacilities-Apps menu; as well as 
seed spreadsheets, font 103 special characters documentation, etc.  Documentation will be updated as 
MicroStation resources evolve.  

Seed UPFs and XMLs:  
Files with these extensions contain various settings, including user settings, button assignments, file and 
folder history, screen layout of tool palettes, menus, etc. The UPF (User Preference File) contains all settings 
that are set in the User Preferences Dialog box, among other things.  

Default files that contain these settings are automatically copied to a folder on the user’s computer. If a 
corruption is subsequently suspected, or if default settings need to be restored or updated, delete the existing 
file/files as needed.  If it is unclear which file is creating a problem, it is normally okay to delete all of the 
files in the folder. The location of these files may vary depending on the Windows version as shown below.  
*Underlined parts of the paths will vary.  

 Windows 7 and Windows Vista: 
C:\Users\d3407\AppData\Local\Bentley\MicroStation\8.11\ago0iv6KXiRYil\prefs  

 Windows XP: C:\Documents and Settings\d3407\Local Settings\Application Data\ 
Bentley\MicroStation\8.11\ KPSKUUqR1pu0tAQ\prefs 

Config Folder                                                                                                                      
this folder contains LADOTD_CAD_Standards.cfg (master configuration file), 
LADOTD_DockingPrefSeed.xml, and seed user preference files (.UPF). 
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 LADOTD_CAD_Standards.cfg: This is the “Master Configuration File”, which defines folder 
paths, MicroStation settings and CADconform settings.  DO NOT MODIFY. 

 \backup Subfolder:  Contains backups of LADOTD_CAD_Standards.cfg, and Workspace 
Project configuration files (.PCF). 

Mdlapps Folder  
This folder contains third party MDL Applications: 

 Steel.ma: Used by the Bridge-Structural discipline to place steel section shapes:  Steel Section 
Parameters must conform to BridgeFacilities CADconform feature table standards.   
See Steel Sections MDL application. 

 CellWiz.ma: Cell manipulation tool 

 Celltool.ma: Places cells on or along elements. 

 InfoSnap.ma: Interface enhancement tools.  See InfoSnap MDL Application. 

 Detailer: Primarily used by the Bridge-Structural discipline to customize and place steel welding 
and finishing symbols.  See Detailer MDL Application. 

Plotting Folder 
DOTD requires ProjectWise Interplot Organizer (Iplot) for plotting DOTD hard-copy and PDF 
drawings.  Iplot is required to ensure that drawing renditions are consistent regardless of which DOTD 
Section/District or Consultant prints the drawing.  Iplot is also used by DOTD’s automated PDF 
publishing application in ProjectWise:  Line widths, line patterns, plot labeling, drawing scale and other 
plotting attributes can be compromised if plotting is not configured consistently.  Attempts to emulate 
output with different plotting software often yield unsatisfactory results.  Attempts to resolve problems 
are often time-consuming, slowing project delivery and collaboration.  Additionally, resolving plotting 
problems increases support time and resulting costs.  DOTD does not have staffing levels to support 
unnecessary plotting problems, nor do most consultants.   

When plotting DOTD drawings, the following delivered resource files are designed to automate plotting 
and ensure consistency: 

Design Scripts (\pen folder) define line widths, line pattern rendition, resymbolization, plot labeling via 
text substitution, and other settings that affect the appearance of printed graphics. 

 Full.pen and half.pen are for Dsize and 11x17 plotting respectively.  These are the default scripts 
that print the default submittal phase (CHECK PRINTS) outside of the left border.   

 Other scripts specify labels for various submittals. For instance, full_fpp.pen prints the plot label, 
FINAL PRELIMINARY PLANS.  See the end of the design script for the plot label text. When 
it is necessary to omit the plot label, use full_nophase.pen or half_nophase.pen. 

Color tables (\ctb folder) define colors for printing.  The default color table is bw.ctb, which is used to 
plot standard monochrome drawings.  For color printing, use bridge-facilities.ctb or road-site.ctb. 

Settings files (\set folder) define settings used to automate plotting.  Plot area, scale, layout, rotation, 
offsets, display attributes, attached design script (pen table) and color table, are among the settings that 
are predefined.  Iplot is now configured to select BorderShape_11x17.set by default, because this is the 
most often used settings file.  Settings file naming conventions are as follows: 

 BorderShape*.set:  Plot limits are defined by a shape element in the file.  These settings files are 
used for printing entire drawings. 
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 ViewFence*.set:  Plot limits are defined by a fence or view boundary.  These are normally used 
for printing specific details.  For view prints, first define the view window and save settings.   

 z_color*.set: For color printing. 

 z_TIFF*.set: For printing scanned drawings in TIFF format. 

* Some minor adjustments to settings files may be necessary.  Edit settings files in Iplot Organizer 
(Edit>Settings Files>Edit).  Permissible adjustments to settings files are as follows: 

 Default printer names may be updated in a Common section. 

 Adjustments to the XY Origin on the Iplot Layout tab may be necessary, depending on the 
specific output device.  Adjust margins to approximately 1/2” (22x34 - top, bottom and right).   

Note: The printable areas on some printers may not be quite big enough to print at target scale.  For 
example, a target drawing scale of 2:1 may print at something like 2.00123:1. This is acceptable. 

Configuring ProjectWise InterPlot Organizer:  Use Iplot Organizer for batch plotting.  
The \Plotting\_cfg folder includes shortcuts and associated batch files, which in turn set default folder 
paths for settings files, pen tables and color tables.  Modify paths in these files as needed to set the 
installation path in the LaDOTD_CAD_Standards Workspace folder.  Deploy the shortcut as needed.   

Alternate Setup:  This setup will configure InterPlot Organizer for operation on the MicroStation File 
Menu (if not already working): Open ProjectWise InterPlot Organizer using the standard shortcut on the 
Windows Start Menu.  Then go to the Edit Menu and select Configuration.  In the Configuration 
Options box, select Edit>Configuration>Common>Edit, which will open IP.CFG.  Add a leading “#” 
character at the beginning of the old IP_SETTINGS_PATH path.  Then add the following path: 
IP_SETTINGS_PATH = C:\DOTD\Workspace\Projects\LaDOTD_CAD_Standards\plotting\iplot\set. 

Using ProjectWise Interplot Organizer in ProjectWise:  Start MicroStation and select File> 
ProjectWise Login>File>Create Plots.  Then Add the DGN Input files and Browse to select the Settings 
file.  Tip: Cancel the ProjectWise dialog box that opens for selecting settings files in order to see the 
MicroStation Workspace Settings File list (DOTD does not currently use “Managed Workspaces”). 

Transparency:  The Transparency element attribute is now supported with features in the 
BridgeFacilities, RoadSite and RoadDesign feature tables.  These features provide various levels of 
transparency and associated shading.  ProjectWise Interplot Organizer, DOTD’s “Publish to PDF” 
application, and Iplot “Preview” all support Transparency.  When printing to paper, you will have to 
check on the “Rasterized” option.  Note: This option can slow down plotting significantly. 

Z_CADconform Subfolders 
 Databases: DOTD CADconform Databases for standards and reports 

 Dictionary Files: Used to Export/Import feature tables or feature table components 

 Docs: LaDOTD help docs, Altiva’s DOTD website docs and feature table enabled docs 

 File DSN: Microsoft Access Datasource Settings 

 HTML: For a spreadsheet rendition of feature table content, logon as an administrator, open 
Feature Table Manager, and Export to HTML file output in this folder. 

 Menus: CADconform Main Menu  

 Users: CADconform User Profiles 
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General Information (Fonts and Line Styles) 
Using Standard Fonts 

 Font 101 (LEROY) is the font normally used for the RoadSite and RoadDesign drafting.  

 Font 103 (design) is the font normally used for the BridgeFacilities feature table drafting.   

 Font 103 is essentially the same as Font 101, except this font contains many more special 
characters.  For a table of special characters and associated keystrokes, see Font 103 Special 
Characters on the DOTD menu, which is located on the MicroStation Main menu 

 The Body .128 (special characters) feature is available in the RoadSite>Annotation feature 
group for placing text strings requiring special characters.  This feature uses Font 103. 

 TrueType fonts are mainly used in embedded spreadsheets and Traffic TSI drawings.  These 
fonts are likely to be used more in the future. 

Font Display Issues and Solutions 
 Most legacy fonts are saved in the current symbology files so that they will be available for 

viewing in older drawings. 

 If fonts do not display properly, view the drawing an appropriate legacy Workspace (if 
available). In some cases the old fonts can be found and added to a current font library. 

 If using old details in a new project, the entire drawing must be conformed to the new standards. 

Line Style Display Issues and Solutions 
 If the element-based line style scale is not set to 1.0 

o Select the affected line styles and change the element line style scale to1.0 (type change 
line style scale 1), or set specific line styles using the Element>Line Styles>Custom menu. 
Then set the global active linestylescale equal to the engineering scale.  Example type 
active linestylescale 50.  

o Special case:  If a line (e.g., a survey utility line) is too short to display the line pattern.  In 
this case, after following the procedure above, adjust the element line style scale of the 
short line to a value smaller than 1.0 (e.g., 0.5). 

 If an old drawing has been copied for use in a new project, first conform the entire drawing to the 
latest standards using CADconform; and then set the active linestylescale appropriately.   

 Legacy Line Style Viewing: Most legacy line styles are saved in the current symbology files so 
they will be available for viewing in older drawings. 

 Line style definitions are sometimes updated, so a line in a legacy drawing may not appear 
exactly the same as it did before.  Under certain circumstances a new, renamed version may be 
created so that the old one can remain available for future viewing. 

 If a line style has been renamed in the line style library (unusual), conform the lines to the new 
line style name using CADconform, or simply change the element’s line Style name. 

 If you have a problem viewing line styles in legacy project drawing, view it in an appropriate 
legacy Workspace. In some cases, old line styles can be found and added to a current font 
library. 

 If you cannot find line style to fit your needs, request that a new one be created. 
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Important Functionality 
Global Active Linestylescale Setting Solves Scaling Problems 
If a border is measured in feet (e.g., 22’x34’), then the border should be referenced in at the same scale 
as the Engineer’s Scale of the master drawing.  In cases where the border is measured in inches  
(e.g., 22”x34”), as with road plan-profile borders and most other road design borders, then the border 
reference drawing scale will be 12 times the Engineer’s Scale of the master drawing. 

 Set the master drawing’s global active linestylescale equal to the Engineer’s Scale in order to 
resolve differences in border measurement (inches or feet), and differences between the active 
linestylescale of master drawing, referenced drawings and border.  If the Engineer’s Scale of the 
master drawing (printed “full size") is 1”=50’, then the active linestylescale should equal 50. 

Examples of scales resolved by the active linestylescale setting:  

 Urban plan-profile seed files are created at an Engineer’s Scale of 1”=20’ and an active 
linestylescale of 20.  Plan-profile drawings reference survey topo drawings having an active 
linestylescale of 50 and a reference scale of 1.0.  The master drawing’s active linestylescale of 20 
overrides the survey’s active linestylescale of 50, so that both display at a scale of 20. 

 Border grids for plan-profile drawings are measured in inches (e.g., 22”x34”), so the active 
linestylescale is 0.0833 (1/12) for grid line display in the border drawing.  These borders are 
referenced into urban plan-profile drawings at a scale of 240 (12x20); and into rural plan-profile 
drawings at a scale of 600 (12x50).  The master drawing’s active linestylescale (20 or 50) is 
equal to the Engineers Scale; and will override the active linestylescale of the border and survey. 

Tip: To view the active linestylescale (at bottom of interface), type “active linestylescale”; then ‘Enter’. 

Tip: Avoid applying a “line style scale” directly to the line element.  The true line style scale would 
then become a multiple of the global active linestylescale setting and the element line style scale.  
Exception: If you have a very short line where the line style pattern is too large to display any line style 
symbol, then it is acceptable to compensate by setting the element line style scale to a value less than 
1.0; enough to show the symbol. 

Tip: Do not use MicroStation Annotation Scale setting in conjunction with the DOTD CADconform 
annotation scaling methods documented above. 

Use element line style scale (not active linestylescale) on Pavement Marking drawings.  
The active linestylescale setting can be used for all DOTD drawings, except for drawings that include 
Pavement Marking line styles.  These line styles represent actual pavement markings (not symbols), 
measured in real world units.  Place Pavement Marking line styles at an element line style scale of 1.0 
and other custom line styles at element line style scales equal to the Engineer’s Scale (e.g., 20). 

Using Enter Data Fields 
DOTD uses MicroStation Enter Data Fields for ‘fill in the blank’ functionality.  These fields are 
distinguished by their underbar display characters.  For example, see the Sheet Number fields on the 
Title Sheet Index.  Use the Enter Data Field commands on the MicroStation Text menu for placement 
and editing.  The Edit Text command can also be used for editing.  Setting the Text Editor to Dialog Box 
is probably the best option in this case (Workspace>Preferences>Text>Text Editor Style> Dialog Box) 

Title Block Enter Data Fields 
DOTD title blocks include Enter-Data Fields as placeholders for text entry.  Select the Fill in Single 
Enter Data Field command on the Text menu.  Then select the data field and enter the text. 
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Title Blocks are usually a combination of data field information in the referenced border drawing and 
data field information in the master drawing.  Use border data fields for information that will be constant 
for all drawings referencing that border; typically State Project Number, Parish, and Section/District/ 
Firm name.  Use master drawing data fields for information that can vary from drawing to drawing, such 
as Control Sections, Revisions, Sheet Number, Drawing Title, etc.  Exceptions are as follows: 

 Title Sheets started prior to CAD Standards release 3.0): Border and all title block annotation 
is included in the master drawing, rather than referenced. 

 Road Cross-Section drawings:  Fill in the constant data field information in the master drawing 
before copying the border for the number of cross-section drawings needed.  Then fill in the 
variable title block information for each drawing. 

Placing Engineering License Seals 
CAD Administrator Instructions:   
Generic (John Doe versions of engineering license seals are provided in the \cell\ publishing Workspace 
folder.  Seals for the Road-Site discipline are in road-site_seal_e-sigs.cel and road-site_seal.cel.  Cells 
for other disciplines are in seal.cel or seal_e-sigs.cel.  To create a new seal, open the appropriate cell 
library, copy a generic seal model and update to the new cell model Name and License No., with the 
individual engineer’s name and license number.  Repeat this process for each new seal.  Do not change 
text attributes of the seal. If the engineer’s name is too long, scale it down to fit comfortably inside the 
seal.   Do not change the other verbiage on the seal.  Be sure to backup seal cell libraries for your site 
before upgrades of MicroStation resources.  Then replace the delivered library with the customized 
library, or update as directed. 

Engineer Instructions:   
Use the RoadDesign, RoadSite, BridgeFacilities or RightofWayMap feature table (as branded on the 
drawing) to place the appropriate seal so that it will automatically scale correctly.  The active seal 
feature will default to one of the generic seal cells.  Then select the ‘magnifying glass’ icon in the Place 
Active Cells toolbox and browse to find the required seal cell for the individual engineer (in the same 
library).  Double-click to activate the cell for placement.  The steps in the process are illustrated below. 

               

1. 1. Activate Seal Feature       2. The default Seal is now active  

3. Select ‘magnifying glass’ to open the seal                                    
cell library and then select your seal. 
- Continued on next page - 
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4. Select Your Seal for Placement 

Cell Selectors 

 

Cell Selectors Menus for Signs and Pavement Markings are now available in the CADconform Traffic 
Feature Table, which is allowable for the Traffic, Road-Site and Bridge-Facilities Workspace Projects.   

 Two types of Cell Selectors are available in CADconform. The one above is an example of a 
MicroStation Cell Selector.  CADconform Cell Selectors are in the form of a list that includes 
name and description columns that can be scrolled through. The current cell displays to the right. 

Describing Facilities Levels - Mechanical, Electrical and Architectural 
Generic level names are used for the Mechanical, Electrical and Architectural disciplines.  Seed file 
levels include Mech, Elec and Arch levels (e.g. Elec1-Elec20).  Generic naming is necessary because of 
the varying, unpredictable nature of level functions for these disciplines.  Unlike levels for other 
disciplines, levels for these disciplines are included in the seed files so that the generic level description 
(“<If used, add description to design>”) can be updated to a real-world description.   

 You will find tools to help manage “Facilities” Levels on the BridgeFacilities-Apps menu.   
Be sure to read Bridge-Facilities Menu Help. 

 The ControlCAD Check CAD Standards report will count levels with the generic descriptions, so 
you will need to accurately describe the used levels, and then use the Delete Unused Levels 
function (on the “DOTD” Menu) finish the cleanup. 
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Embedded Spreadsheets  
Embedded spreadsheets may be used to create summary tables in MicroStation. Information as follows: 

 Some Microsoft Office Excel spreadsheets are furnished in the DOTD CAD Workspace.  These 
currently include Bridge Bent and Traffic TSI computations. 

o Bridge Bent – Open the Bridge_Bent_Quantities.xls spreadsheet, located in the 
\docs\seed spreadsheets folder 

o Traffic TSI – Embedded in Traffic TSI Seed Files 

o Road-Site – Use similar procedures as for Bridge below.  Format for feet (e.g., 20.00’). 

 The Bridge_Bent_Quantities.xls can be used as a seed or example setup for new Bridge quantity 
spreadsheets.  Do not modify the example file. 

1. Starting in Microsoft Excel, select the table to be embedded and Copy it to the clipboard.  
In MicroStation, pick Edit>Paste Special>Embedded Microsoft Office Excel<version> 
Worksheet.  On the MicroStation Paste Ole Object settings box, paste as Embedded using 
the By Size method.  Set Scale to 20 times the Engineering Scale of the drawing, or 20/12 
times Engineering Scale for Road-Site.  Spreadsheets must be embedded, not linked 

2. Double-click on the spreadsheet image in MicroStation to open it in Excel.  The Protect 
Sheet feature is turned on by default to prevent accidental modification.  You must 
Unprotect Sheet to make modifications 

3. Use the same fonts and font sizes used in the example Excel file.  Many other familiar 
fonts will not work as well when printed from the CAD file.  

 Users are responsible for submitting accurate quantity computations.  Provided spreadsheets are not 
guaranteed to be accurate.  Please report any problems that you find so that they can be fixed. 

 Axiom’s Microsoft Office Importer may also be used to create tables for quantities and other 
purposes.  This application produces CAD elements, which are subject to CADconform standards. 

InfoSnap - Third Party MDL Application 

 Instant access to element source, attributes, and data. 

 With a single click of the tentative button you instantly have all the information you could wish 
for, right next to the cursor.  

 Additionally, you can instantly make element attributes active and reuse them for new elements 

 Gain full control over AccuSnap's balloon 

 Perform instant navigation across reference files and DGN models  

 Cleanup precious working area by automatically hiding or shrinking (and expanding) 
MicroStation dialog boxes on cursor flyover. 

 Create context-sensitive menus popping up automatically at your cursor when needed  

 Perform ad-hoc length estimates directly in graphics while executing another tool… 

 No technical support provided by DOTD.  Descriptions are provided by the developer 

 Comments regarding problems or usefulness of this application are welcome. 
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Steel Section - Third Party MDL Application 

This application is used in by the structural drafting to place steel section shapes.  It includes a library of 
many shape types and allows Steel Section Parameters to be set and saved.  These parameters include 
color, weight, line style and hatching pattern style.  The appropriate parameters are shown below.  
Spacing Factor and Hatch Angle may need to be adjusted.  

 

  

 

 

 
 
Detailer - Third Party MDL Application 

This application is primarily used to customize and place steel welding and finishing symbols.  Set 
active level to Annotation, place symbols using Detailer, and conform using the CADconform 
BridgeFacilities feature table, if necessary.   

 The Datum function is not working as of this writing.  Do not turn it on!  It will crash 
MicroStation if you try to use it. 

 Activate Detailer from the BridgeFacilities-Apps menu 
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CADconform 

CADconform Setup 
The Altiva CADconform software download is located at www.altivasoft.com/ladotd/.  General steps for 
setting up are as follows: 

1. Load the software.  If this is your first time, you might want to contact Altiva Software Support 
at (281) 295-2254 to assist you with installing the software and obtaining a license key. 

 The installed CADconform software configuration file (CADconform.cfg) sets defaults 
that control how CADconform operates.  Do not alter this file. 

 The LaDOTD_CAD_Standards Workspace delivers custom CADconform setting that 
may override CADconform.cfg.  Do not alter these settings. 

2. Load the software and drop the license key in the \CADconform\License folder 

3. Start CADconform from the CADconform menu (located on the MicroStation Main menu) 

4. Open User Manager to create new user profiles and manage user privileges as needed.  
Two seed user profiles (dotd admin and dotd user) are delivered in User Manager.   
The default passwords are “admin” and “user” respectively.  Instructions as follows: 

5. Change the password of the installed dotd admin profile, and save a copy of cadconform.pwl, 
which is located in \LaDOTD_CAD_Standards\z_CADconform\users\ 

6. Use the New User command in User Manager to create new user profiles for your site (if 
needed).  An appropriate source profile should be selected before running the command so that 
the source settings will be copied to the new profile.  Update settings when appropriate. 

Note:  The delivered user profiles are appropriate for most users, and should not be changed 
without careful consideration. Some examples of permissible changes are as follows:  

 Allow trusted users to brand drawings 

 Allow Draft to load on startup 

 Lock feature tables 

CADconform Operation 
Each tool in the CADconform Toolbox (e.g., Draft and Conform) includes valuable commands and 
useful settings.  Please take time to become familiar with these tools, and use help files as needed. 

Feature Table Manager:  Enables DOTD discipline administrators to create standard discipline-
specific menus of features that are used for drafting and checking DOTD plans.  Also useful for 
designers to review feature functionality and identify features in design. 

Draft:  Enables designers to draft plans using the standard DOTD feature table menus. 

Conform: Used like a spell checker to check CAD standards for conformance and fix problems. 

Batch Processor (“Generate Reports”):  Includes functions to certify drawings, run reports and 
execute batch processes on drawings.  The Reports function is used to generate reports about drawing 
features, errors and watermarks.  The Certify function is used to affix a drawing’s “DOTD CAD 
Standard” certification stamp in the upper left border margin area.   

User Manager: Used by administrators to create new users and manage user privileges, as described 
under CADconform Setup above.
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CADconform Feature Tables 
The following feature tables are available for designing, conforming and certifying DOTD drawings.  
Seed files are “branded” to automatically load feature tables that are normally needed.  Other feature 
table brands may be added as long as they are specified as Allowable for the Workspace Project. 

RoadDesign: Includes roadway design and related site work (Roadway, Typical Sections, Cross 
Sections, Hydraulics, Driveways, etc.) 

RoadSite: Includes features that are common to site work, and minor roadwork such as access roads and 
sidewalks.  This includes Annotation, Erosion Control, Site Prep/Protection, Generic Site Plan and 
Landscape feature groups. 

BridgeFacilities: Includes Annotation, Bridge and Structural feature groups.  Also includes Site 
Prep/Protection and Generic Site Plan feature groups (similar to RoadSite).   
CADconform Cell Selectors are provided for bridge spans and bents (scales must be set manually, 1:1 
or drawing scale, as appropriate).  

Architectural: Used along with the BridgeFacilities feature table’s Annotation feature group 

Electrical: Used along with the BridgeFacilities feature table’s Annotation feature group 

Mechanical: Used along with the BridgeFacilities feature table’s Annotation feature group 

Traffic: Traffic Signs, Signals, Pavement Markings, Misc. Line Styles, etc.: Normally used along with 
either BridgeFacilities’ or RoadDesign’s feature table’s Annotation feature groups. 

TitleSheet: Includes two major feature groups:  Seed File Features and Project Specific Features 

Survey: Features for electronic surveys (generated by Inroads Survey), which are referenced to plans 

RightofWayMap: Features for Right-of-Way-Map drawings 

_ReviewCellLibrary: Used primarily as a quick way to review cell libraries.  Cells placed using this 
tool will not automatically scale properly, and should not be used for drafting. 

_PreviewDictionary: Used to review dictionary files before deleting or importing into standard feature 
tables.  It is often useful to know what you are getting before importing. 

Important Information about CADconform Features 
Feature Table Branding Issues: Drawing Seed Files (templates) are named according to their general 
function, and include “branded” feature table attachments.  Brands are denoted by a red circle containing 
a ‘B’ in Feature Table Manager.  It is not practical to cover all possible combinations of feature table 
brands in separate seed files; so it is permissible to add or remove feature table brands when appropriate.  
See the “Transition Guide” for additional information. 

Feature Settings: Feature Table Manager can be used to become familiar with specific settings that are 
used for drafting and conforming drawings (element attributes, scales, default commands).  Double-click 
on a feature or select the “wrench” icon to view the Advanced Feature Options tabs. 

Feature Commands and Add-ons:  CADconform features are normally designed to use a commonly 
used default command (e.g., place smartline) along with some optional settings and added key-ins.  It is 
usually permissible to change the command after selecting the feature (e.g., change to place block 
command), or to apply settings that are not checked Conform (e.g., default patterning attributes).   

 “Variable” Features: DOTD allows variations from default feature attributes in certain cases.  For 
instance, Concrete Object Lines are placed at weight 2 by default, but in some cases these features may 
need to be displayed lighter (subdued) or heavier (bold).  CADconform features allow such variations in 
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a single feature by using Ranges (pick lists) of element attributes.  Variations of element weight, style, 
color and level are allowed in varying combinations where appropriate. 

Hidden Features: These are features that are not used for drafting, so they are hidden in the Draft 
menu.  Such features include those used to cover elements generated by Inroads.  Other Hidden Features 
are used to allow certain outdated drafting features to pass the Conform checker.  Such features can 
optionally be displayed in the Conform checker pick list (magenta color). 

Drafting Menu Tear-Off Option:  DOTD feature tables are designed to take advantage of the Draft 
Short Menu Tear-off option. This option is available at the bottom of each feature group.  Use this 
option to isolate specific feature groups, which are needed for the task at hand, in separate drafting 
menus.  This function is particularly helpful when using large feature tables, such as RoadDesign. 

Cell Scaling Methods: Border scale (for annotation); real world (1:1); or diameter (in feet) (plants). 

Why not use ByLevel settings to drive standards?  CADconform feature tables support ByLevel 
functionality, but using ByLevel settings altogether, in lieu of CADconform features, is generally not 
practical for DOTD drafting. Although DOTD uses ByLevel color extensively, ByLevel weight and line 
style are not used so often.  Feature table Ranges provide flexibility for color, line style and line weight 
combinations, without having to extensively add unneeded levels.   

CADconform features also add new facets to CAD standards that cannot be addressed with ByLevel 
settings.  They can be used to run macros and key-in commands, set scales, apply settings, etc.  They 
essentially function like mini-macros. 

Why not use element Match commands to draft?  Some designers like to place elements on the side 
and match them as they draft.  This leaves unwanted clutter, and such elements can become out of date. 

Preparing Plans for Submittal 
 Fix issues that are not checked by CADconform.  These issues usually show up in red in the 

ControlCAD Check CAD Standards report that DOTD reviewers run in ProjectWise.   
See General Rules below. 

 Remove elements that are outside of the drawing border if possible.  Move elements to a new 
Design Model if they need to be saved or referenced. 

 Use DOTD Menu to Delete Unused Levels and Delete Unused Linestyles. Then compress file. 

 Certify MicroStation drawings 

General Rules for Certifying Drawings 
It is important to use the following guidelines when preparing CAD drawings for delivery: 

 Certify all project deliverable MicroStation Design Files using CADconform.  Evidence of 
certification is a valid DOTD CAD Standard stamp. 

 Certify all Reference Files (DGN format) 

 Certify Standard Drawings that include a completed title block and referenced CAD border 

 Certify Surveys.  Place the certification stamp near the left side the survey Project Note 

 Do not certify borders.  Do use the Conform checker to ensure that elements still conform.
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ControlCAD Tools 

ControlCAD has been transformed (according to DOTD specifications) to enable spreadsheet based 
feedback in ProjectWise at each submittal milestone.  This enables QA/QC reports for CAD Standards 
and Attribute indexing to be an ongoing process throughout plan development.  This new process 
applies to DOTD and consultant designers.  A ControlCAD Reports subfolder of the discipline plans 
folder is created when a CAD Standards or Attributes report is first generated.   

Check CAD Standards Report: This application, which is available to authorized DOTD reviewers on 
the ControlCAD right-click menu, creates a Microsoft Excel spreadsheet report that documents the 
status of a MicroStation file’s CAD Standards.  Column header labels and drawing file feedback, which 
are subject to change, are as follows: 

 Document Name - (name*); or (name*)- Red text: Sheet number format issue,  or 
problem issues in other columns (same row) 

 CAD Stamp:  “OK”, “Missing”, “File Modified” , “DGN not v8” 

 Refs:  “Attached” , “None” or “Missing” and names* (“N/A” for border file) 

 Border Ref:  “OK” and  name* (“N/A for Ref” for border file) 

 Drawing Scale:  “border” or “user”;  and value or “none” 

 Active Linestylescale:  value or value 

 Missing Level Descriptions:  number* or “OK” 

 Orphan Cells:  number 

 AutoCAD Styles:  “yes” or “no” 

 Working Units:  value* or value* 

 Dim:  “2D” or “3D” 

 Inroads Elements:  “yes” or “no” 

 Dictionaries (also called “Feature Tables”):  name and version, or “none” 

Black text:  Usually okay.   Red text:  Fixes are usually required.   * Corner comment info is included. 

 Check Attributes Report:  This application, which is available on the ControlCAD right-click 
menu in ProjectWise, and creates a Microsoft Excel spreadsheet report that documents all of the 
attribute values for all of the files in a Plans folder.  Missing attribute values are listed as 
“BLANK”; attribute values that are not recognized by ControlCAD are identified as “not listed”.  
Corner comments include information, or additional issues that may need to be addressed. 

 Email Reports:  This application, which is available on the ControlCAD right-click menu in 
ProjectWise when one or more reports are selected, emails the reports to selected recipients.  The 
‘auto’ option sends a standardized email to a recipient list that is predefined in the _emails.csv file, 
with body text that is predefined in _body.html.  These files must be located in the ControlCAD 
Reports folder.  The ‘interactive’ option enables users to define recipients and author body text on 
the fly as one would normally do when drafting an email.  This would be handy when recipient 
lists may vary and boy text may include variable instructions including more specific information. 

 ControlCAD Indexer: This user-friendly application, which is available on the ControlCAD 
right-click menu in ProjectWise, populates indexing attribute values for CAD plans.  These 
attribute values are applied so that future searches can find files with such attribute values. 
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 Effective with DOTD CAD Standards Release 3.0, consultants will not use ControlCAD Indexer 
to index plans or ControlCAD Submittal to package DGN plans and XML index files for 
submittal to DOTD.  Although ControlCAD Indexer is available to DOTD employees, it has not 
been integrated for access by users outside of the DOTD local area network yet.  For additional 
information, contact Paul Mandella, at paul.mandella@la.gov. 


